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Introduction 

Purpose 
This document describes the software interface and tools provided with the ZL30250 Evaluation System.  
Please note that although the document refers to the ZL30250, the evaluation system it describes also 
supports ZL30251, ZL30252, ZL30253, ZL30151 and ZL30169 devices. 
 

Related Documents 
1. ZL30250 Evaluation Board Hardware User Manual. 
2. Applicable device datasheet (as this software supports several devices, refer to the applicable 

datasheet for complete descriptions of supported features and device configurations). 
 

Software Overview 
The ZL30250 Evaluation Software package is fully supported on Windows XP and Windows 7. It may also 
work on older Windows versions. The software package is comprised of: 
1. Device drivers for the FTDI USB interface IC on the evaluation board 
2. Graphical user interface (GUI) software for easy configuration and monitoring of the device 
3. Installation .EXE for the GUI and the FTDI device driver 
4. Evaluation Software User Manual (this document). 
 
The software GUI (graphical user interface) provides on-screen graphical controls for all features of the 
devices listed in the Purpose section above. 
  

Target Audience and Prerequisites 
This document is targeted towards development engineers who will install, configure and operate the 
ZL30250 Evaluation Board. Users should be familiar with timing and PLL-related terminology and 
methodology, and the features and operation of the device to be evaluated. Uses for the GUI software 
include: 

• Demonstration of the ZL30250 and related devices, with or without an evaluation board. 
• Device configuration and the creation of configuration files. 

 
This guide only shows the on-screen controls and status displays available in the GUI. Users should refer 
to the appropriate device data sheet to understand what a specific control or status display actually does. 
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Evaluation Software Installation 
Before connecting the ZL30250 Evaluation Board to the Host PC, it is best to install both the Microsemi 
ZL30250 GUI software and the device driver for the evaluation board’s USB interface chip.   

Software Installation 
The installation package for the GUI is typically delivered in a .ZIP file. In this .ZIP file, double click on the 
ZL30250_GUI_[version]_Setup.exe file. The software will guide you through the installation 
process.  
 
NOTE: With the GUI installed, the evaluation software can be used in an “offline” mode, that is, without 
any connection to an evaluation board. Working offline is covered in more detail in the Using the ZL30250 
GUI section. 
 
NOTE: Windows regional settings must be set to English in order to correctly display frequency values. 

Device Driver Installation 
At the end of GUI installation, the GUI installer gives the option to install the device driver for the 
evaluation board’s FTDI USB interface IC. When this option is selected, the GUI installer runs the device 
driver installer. On most systems this transition from one installer to another happens automatically with 
no error. However, on some Windows variants, device driver installers have to be run with administrator 
privilege or Windows gives an error message. If such an error does occur, try these alternatives: 

1. Run the device driver installer (CDM20830_Setup.exe) from the folder where the GUI was 
installed. This location is “C:\Program Files (x86)\Microsemi\ZL30250” unless a different 
location was specified during GUI installation.  

2. To force this file to be run with administrator privilege, right-click on CDM20830_Setup.exe 
and select Run as administrator.  

Windows Settings that May Need Adjustment 
Some users have font display problems in Windows 7 when the display magnification is larger than 100%. 
To change this Windows property to 100%, go to the Control Panel  Display and change Make it 
easier to read what’s on your screen to Smaller – 100% (default). 
 

Launching the Evaluation Software GUI 
During the software installation, access to the ZL30250 GUI will have been added to the “All Programs” 
list in the Windows Start menu under the Microsemi ZL30250 program group (unless otherwise changed 
by the user during installation). To launch the GUI, click the ZL30250 link in this group. Refer to the 
sections below for further details on all features available. 
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Using the Evaluation Software GUI 

Startup Window 
Below is the initial “splash” window that appears when the program is launched. The only menu items 
available at startup are File and Connection. Before any of the other items are made available, a 
connection must be made to a ZL30250 board, or the Work Offline option selected (see the next section). 
Note: Your software installation may show a different version number. 
 
 

 

Figure 1: Startup Window 
 

Connection Menu 
By clicking Connection in the menu bar, the following Device Selection window appears: 
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Figure 2: Device Selection Window 

 
The GUI software can be used with or without an evaluation board connected. 

Working Offline (No Evaluation Board Connected) 

To work offline, select the desired device in the Part Number dropdown box and click the Work Offline 
button. The GUI then formats the GUI main window for the selected device and displays the Initial 
Configuration Window). The main purpose of working offline is to allow the user to set up a desired 
configuration, then save the configuration using the File menu. These settings can then be loaded back 
into the GUI and optionally into a device on an evaluation board at a later time. 

Connecting to a Device 

The Connect to Device frame in the Device Selection window shows a list of all compatible evaluation 
boards attached to the PC’s USB port(s). If an expected board does not appear in the list, verify the USB 
cable connection and power supply to the evaluation board, then click the Refresh button to the right of 
the list several times waiting about 5 seconds between clicks. It may take a few seconds after a 
connection or power up for Windows to negotiate the USB connection and find the device. If the expected 
device is still not found, see Appendix A. 
 
Click an entry in the device list to select it then click the Connect button. The GUI then takes a few 
seconds to read in device information and configure the main window.  
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Initial Configuration Window 

After a successful connection has been made (or a device has been selected for Work Offline mode), the 
GUI displays the main window for the connected or selected device. On top of the main window the GUI 
displays the Initial Configuration form shown in Figure 3.  
 

 
Figure 3: Initial Configuration Window 

 
The Initial Configuration form asks the user to specify the starting device mode (see Specifying the 
Device Mode below) and describe the oscillator or crystal connected to the device’s XA/XB pins on the 
evaluation board. When the GUI is connected to an evaluation board it is critical that the XA/XB 
information match the actual evaluation board configuration. When the GUI is operating in Work Offline 
mode, the XA/XB information must match the intended application if the GUI is used to generate 
configuration files. 
 
Figure 4 shows the main control window for a ZL30169 device in its jitter attenuation device mode. Other 
devices will look similar, but some control elements may or may not be present. A yellow “Working 
Offline” indicator will be displayed at the top of the window, as shown in Figure 4, when the software is in 
Work Offline mode. 
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Figure 4: Main Control Window 

 
 

On-Screen Controls and Status Displays 
Device controls are grouped according to function in the main window, and follow a signal progression 
from the inputs on the left, through the DPLL controls, to the APLL and outputs on the right.  
 

Specifying the Device Mode 

The device’s main operating mode can be changed using the Device Mode control at the top of the main 
window. Microsemi devices supported by this software have various combinations of four device modes: 

• Frequency Synthesis mode, which uses the APLL for frequency multiplication or 
frequency conversion 

• Numerically Controlled Oscillator (NCO) mode, which is a frequency synthesis mode that 
has high-resolution software steering of the device’s fractional frequency offset 

• Spread Spectrum mode, in which the device can be configured to modulate its output 
clock frequency to reduce system EMI 
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• Jitter Attenuator mode, which uses the digital PLL (DPLL) in front of the APLL to provide 
low bandwidths for jitter attenuation, holdover, controlled reference switching and other 
features 

 

Specifying the Reference Type and Frequency 

In DPLL, NCO and spread spectrum device modes, the device requires a master clock signal on its 
XA/XB pins. The type and frequency of the master clock can be specified in the Master Clock box in the 
upper-left corner of the main window. Valid frequency ranges for XO and crystal reference types vary with 
device mode. If an invalid frequency is entered the GUI displays the valid frequency range. 

In frequency synthesis device mode, a master clock is not required. A crystal connected to the XA/XB 
pins or a clock signal connected to the XA pin becomes a fourth input clock to the APLL in this mode.  
 

Connection Lines on the Main Window 

The main window dynamically displays lines to show connections among blocks in the device. Examples 
include which input clock is the selected reference for the DPLL and which of the APLL’s high-speed 
dividers (HSDIV1, HSDIV2) is the source for each output clock. 
 

Input Configuration 

Enable and Invert 

The Enable Pins checkbox for each input enables and disables the device’s receiver logic. When 
checked, the Invert checkbox adds a signal inversion in the input clock path. 
 

Frequency 

Each input has a Frequency box on the main window. For each input that is used in the device 
configuration, enter the frequency in MHz in the box. For inputs that are not used, enter 0 in the frequency 
box.  
 
The following constraints must be met for input clock frequencies: 

In Jitter Attenuation (DPLL) device mode: 

• The input frequencies must be divisible to a common DPLL PFD frequency 
≥ 1kHz. Each input clock can be divided by any integer. The software shows the 
common PFD frequency it chose in the main window DPLL box.  

• The common PFD frequency must be > 20 times the DPLL bandwidth.  
In Frequency Synthesis (APLL) device mode: 

• The input frequencies must be divisible to a common APLL PFD frequency 
between 9.72MHz and 156.25MHz. Each ICx input clock can be divided by 1, 2, 
4 or 8.  

• The XA pin behaves as a fourth input when the XA/XB Frequency is not 0. The 
XA input does not have an internal divider. Therefore, when XA is enabled as an 
input its frequency is the common APLL PFD frequency. 
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Help with Fractional Frequencies 

Some frequencies used in communication systems and other applications make use of clock frequencies 
that can only be exactly expressed as ratios of integers. For example, a common forward error correction 
rate in communication systems is 155.52MHz * 255 / 237. This frequency cannot be expressed exactly as 
a single decimal number because the digits to the right of the decimal never terminate. 
 
When the Frac button to the right of each input frequency box is pressed, the software opens a window in 
which a frequency can be expressed as a Base Frequency multiplied by one or more numerator integers 
N1, N2, etc. and divided by one or more denominator integers D1, D2, etc. 
 

DPLL Input Monitor Configuration 

In jitter attenuation device mode each ICx input has a Config button displayed. When this button is 
pressed, an ICx Configuration window appears. At the top of this window are read-only indicators of how 
the software has set the input clock’s high-speed and 20-bit input dividers. The rest of the window allows 
the user to configure activity and frequency monitors for the input.  
 
Here are some notes about the monitor settings available in this window: 

• Monitor State = “ON (High Gap Tolerance)” configures the monitor so that gaps (i.e. 
missing cycles) in the input clock can be tolerated (i.e. ignored). As an example, in 
communication systems, some OTN demapper functions create such gapped clocks as a 
digital frequency conversion technique. In DPLL device mode the device can accept such 
gapped clocks and output smooth, non-gapped clocks. 

• In the Monitor Mode selections, frequency monitoring < 500ppm (only available in 
ZL30151 and ZL30169 devices) has both accept and reject thresholds that can be set 
with approximately 1ppm resolution. Using separate accept and reject thresholds 
provides hysteresis which many applications require to avoid excessive input reference 
switching. When the Disable Hysteresis checkbox is checked, the reject threshold is 
removed and the accept threshold becomes the one single threshold. In all frequency 
monitoring there is a tradeoff between reaction speed and accuracy. The longer a signal 
can be averaged the more accurate its frequency can be determined, but longer 
averaging time mean slower reaction time. The PPM Monitor Mode control allows the 
user to specify a preference for faster reaction time or higher accuracy. 

• In the Monitor Mode selections, frequency monitoring >=1% is faster than any PPM 
monitoring mode but is correspondingly less accurate. This mode is used for applications 
where the only concern is to invalidate the input if it is grossly off frequency, i.e. by 1% or 
more. 

DPLL Input Monitor Status 

In jitter attenuation device mode each ICx input has a Status button displayed. When this button is 
pressed, an ICx Status and Monitoring window appears. This window provides several status indicators 
and shows the device’s internal logic that combines these statuses into the overall valid/invalid status for 
an input clock.  
 
Here are some notes about the fields in this window: 

• The Validation Timer specifies an amount of time that the input monitor and LOS source must 
indicate that input clock is valid before the device actually declares it valid.  
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• LOS Source specifies a GPIO pin as a loss-of-signal input. This GPIO pin could be connected to 
the LOS output of an Ethernet PHY, for example. This allows the PHY to very quickly cause the 
disqualification of the input clock signal when the PHY receiver is no longer receiving a valid 
signal.  

• The Loss-of-Signal Latency control allows the user to specify how long it takes for the PHY to 
declare loss-of-signal on the GPIO pin after the event occurs. 

DPLL Configuration and Status 

DPLL configuration and status are available in the DPLL box in the main software window and also in the 
DPLL window, which can be opened by pressing the DPLL button in the main window. 
 
In the main software window, the Mode control can be set to Automatic to allow the DPLL to 
automatically switch among freerun, tracking and holdover states, or the DPLL can be forced to the 
freerun or holdover states. The DPLL bandwidth can also be set in the main software window. 
 
The DPLL’s read-only State box indicates whether the DPLL is in freerun, tracking or holdover states, 
and, while in the tracking state, whether the DPLL is locked or unlocked according to the lock criteria set 
in the DPLL window. 
 
The DPLL’s Selected Reference can be set to Automatic to automatically select the best reference 
based on the priority and validity of the input clocks, or the selected reference can be forced. 
 
The real-time fractional frequency offset and phase of the DPLL are displayed in the Frequency Offset 
and Phase boxes, respectively. 
 
Here are some notes about the fields in the DPLL window: 

• When External Switching Mode is enabled by selecting a GPIO pin to control it, DPLL 
input reference selection is simplified to a 2:1 mux controlled by the GPIO pin. See the 
external reference switching mode section of the device data sheet before using this 
mode. 

• The User Priorities controls for IC1 through IC3 allow the user to express the relative 
priority of the inputs for use as the DPLL’s selected reference. To the right of these 
priority boxes, the read-only Selected Reference, Priority 1 and Priority 2 boxes 
indicate the real-time prioritization that the device’s selection logic is making based on 
which inputs are valid. 

• See the device data sheet for a description of the Averaging Window and Throw Away 
Window controls (available only in the ZL30151 and ZL30169 devices).  

• The Holdover Offset box displays the fractional frequency offset the DPLL will use when 
it enters holdover (available only in the ZL30151 and ZL30169 devices). 

• The Loss of Lock Set Delay specifies the length of time during which the DPLL must not 
meet its Phase Lock Criteria in order to declare it is unlocked (i.e. loss-of-lock).  

• The Loss of Lock Clear Delay specifies the length of time during which the DPLL must 
meet its Phase Lock Criteria in order to declare it is locked.  

• The Phase Lock Timeout control specifies the length of time the DPLL will remain 
unlocked in the tracking state before it declares the selected reference invalid. A value of 
0 means do not declare the reference invalid due to failure to lock. 

• The Lock Alarm Timeout control specifies the length of time that an input previously 
declared invalid due to phase lock timeout will remain invalid. 
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• The hitless switching Phase Averaging Window is the length of time the DPLL 
measures the phase difference it must absorb before performing the hitless switch 
(available only in the ZL30151 and ZL30169 devices). 

 

APLL Configuration 

The configuration of the APLL is handled almost entirely by the software. The software chooses the APLL 
VCO frequency and HSDIV1 and HSDIV2 divider values needed to create the OCx output clock 
frequencies specified by the user. 
 
In frequency synthesis device mode, the APLL box in the main window provides controls to specify the 
input reference clock to the APLL. When External Switching Mode is disabled, the APLL’s reference is 
specified by the Source control. When External Switching Mode is enabled, the GPIO specified by 
External Switching Mode Control Signal selects the input specified by Source when the GPIO is low 
and selects the input specified by Alternate Source when the GPIO is high. 
 
Clicking the APLL button opens the APLL Configuration window. At the top of this window are read-only 
indicators of how the software has set the APLL’s HSDIV1 and HSDIV2 high-speed dividers. The rest of 
the window has APLL Phase Adjustment controls. These controls provide a fine phase increment or 
decrement for all output clocks simultaneously. 
 

Output Configuration 

Format and Status 

In the software main window, each output has a Status box. This box displays Disabled when the 
Format control is set to Disabled and displays Enabled when the Format control is set to any other 
setting. The Status box also displays Stopped when the output has been stopped using the stop controls 
in the OCx Configuration window.  
 
In the output Format box, CML (800mV) is standard CML signal format. CML (400mV) is a half-swing 
mode that reduces output power consumption. The 1 CMOS-N option enables the OCxN pin as a CMOS 
output while OCxP remains high-impedance. The 1 CMOS-P option is similar, with OCxP enabled as a 
CMOS output and OCxN high impedance. The 2 CMOS-Comp option enables both OCxP and OCxN as 
CMOS outputs with OCxP inverted. The 2 CMOS option enables both pins as CMOS outputs in-phase 
with one another. 
 
In the OCx Configuration window, an optional inversion can be added to the output clock path by 
checking the Invert box. The device can be configured to automatically squelch (i.e. stop) the output 
clock when the DPLL has no selected reference by checking the Auto-Squelch box. 
 
An output’s duty cycle can optionally be set to something other than 50% nominal using the Pulse Width 
controls. The desired high pulse width is entered into the Requested box, and software displays the 
closest achievable pulse width in the Actual box.  
 
An output’s phase relative to the other outputs can be set using the Output Phase Alignment controls. 
The desired phase is entered into the Requested Phase box, and software displays the closest 
achievable phase in the Actual Phase box. 
 
An output can also be configured to stop when a GPIO pin or a register bit changes state. Outputs can 
stop low, high or high-impedance. 
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Frequency 

Each output has a Frequency box on the main window. For each output that is used in the device 
configuration, enter the frequency in MHz in the box. For outputs that are not used, enter 0 in the 
frequency box.  
 
The following constraints must be met for output clock frequencies: 

• Output frequencies must be integer divisors of one of the APLL’s high-speed divider 
frequencies. 

• The HSDIV1 and HSDIV2 frequencies must have a common multiple in the VCO 
frequency range, which is 3715MHz to 4180MHz. The HSDIV1 and HSDIV2 dividers can 
each divide by integers from 4 through 15 and half divides from 4.5 through 7.5.  

The outputs have a Frac button and window to help specify frequencies that can only be specified exactly 
as ratios of integers. See Help with Fractional Frequencies in the Input Configuration section above for 
details. 
In the Frequency section of the OCx Configuration window the “frequency trail” is shown, starting with 
the high-speed divider that is the source for the clock then the medium-speed and low-speed divider 
values, then the final output frequency. 
 

Main Window Menus 

File Menu 

The GUI has the following options under its File menu: 
 

• Load Configuration 
• Save Configuration 
• Create EEPROM Image File 
• Write Image to EEPROM 
• Dump DUT EEPROM to File 
• Register Dump File 
• Exit 

 
These options are further explained below. 

Load Configuration 

There are two file types that can be loaded: a GUI configuration file and a DUT configuration file. These 
configuration files can be created by the Save Configuration menu option described below. See below 
for descriptions of these file types. 

Save Configuration 

Two types of configuration files can be saved by the GUI: GUI configuration files and DUT configuration 
files.  
 
GUI configuration files are text files that contain all the information necessary to configure both the GUI 
and the DUT.  
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DUT configuration files (also known as mfg files because they use a “.mfg” file extension) are text files 
that contain an ordered sequence of write commands and wait commands that can be followed to 
configure a device. These mfg files can be easily converted to a format usable in a customer’s system, 
and system software can execute the commands to configure the Microsemi device during system start-
up. DUT configuration files can also be used as input for the creation of an EEPROM image file as 
described below. 
 
Both of these file types can be loaded back into the GUI at a later time using the Load Configuration 
menu option. It is not necessary to understand anything about the content of these files to use them. 
 

Create EEPROM Image File 

Microsemi part numbers ZL30251, ZL30253, ZLZ30151 and ZL30169 device have internal EEPROM and 
can automatically configure themselves at reset from this internal EEPROM. ZL30250 and ZL30252 
devices can, as a design option, auto-configure themselves from an external SPI EEPROM. Up to four 
device configurations can be stored in EEPROM memory and selected by the state of the AC[1:0] pins 
during reset. 
 
An EEPROM image file is a text file that lists the contents of the entire EEPROM memory. When Create 
EEPROM Image File is selected from the File menu, the GUI opens a window in which the user can 
specify up to four DUT configuration files (.mfg files) as input files and an EEPROM image file as an 
output file. When the Create button is pressed, the GUI automatically combines the input files and creates 
the image file. 
  
In this window the GUI fixes the EEPROM Size value to 2kbyte and the EEPROM SCLK Frequency 
value to 5MHz for parts with internal EEPROM. For parts with optional external EEPROM these values 
can be set by the user. 
 
The GUI can create three different output formats: Intel HEX, Motorola S-record, and “ASCII” format, 
which has one 2-digit hex value per line arranged in order from EEPROM address 0 to max EEPROM 
address. The format is specified in the Browse dialog for the EEPROM image file in the Save as type 
field.  
 

Write Image to EEPROM 

After an EEPROM image file has been created as described above, the Write Image to EEPROM option 
in the File menu can be used to write the file’s contents to the EEPROM in the DUT (ZL30251, ZL30253, 
ZLZ30151, ZL30169) or a separate EEPROM on the evaluation board (for use with ZL30250 or 
ZL30252). The GUI automatically verifies the data after writing. 
 

Dump DUT EEPROM to File 

This GUI function reads the contents of the DUT EEPROM and writes the information to an EEPROM 
image file. 

Register Dump File 

This function creates a file containing a complete register dump of the DUT. 
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Tools Menu 

The Tools menu has the following items: 
• GPIO Configuration 
• Register View 
• Documentation 

 
These options are further explained below. 
 

GPIO Configuration 

When this menu item is selected the GUI opens the GPIO Configuration window. In this window the 
DUT’s GPIO pins can be configured as input, output low, output high or status outputs. Status outputs 
can be configured to follow any status register bit in the device. Status outputs can also be configured for 
normal or inverted polarity and push-pull or open-drain behavior. 

Register View 

This menu item opens the GUI’s Register View window. This window shows the current values for every 
register in the device. Tabs at the top of the window group registers by type and section of the device. 
Most of the window provides an array where the names, addresses and values of the register are 
displayed. When the user clicks a register in this array the bit fields of that register are displayed at the 
bottom of the window. Byte values of registers can be written in the register array, and bit values of fields 
can be written at the bottom of the window.  
 
Some device register fields span multiple addresses. The multi-register fields can be written all at once by 
clicking one of the field’s register in the register array part of the window and then double-clicking the 
name of the field in bit field display at the bottom of the window. For example, to write the AFBDIV field all 
at once, in the APLL tab click the AFBDIV1 register then at the bottom of the window double-click 
AFBDIV[7:0]. A window appears in which the entire AFBDIV value can be entered. 
 
Warning: Writing registers directly can cause unexpected results and should be avoided. Whenever 
possible users should affect register values through other GUI fields rather than through the Register 
View window. 

Documentation 

This menu items allows the user to open several helpful documents including: 
• This GUI manual 
• GUI release notes 
• Evaluation board quick-start guide 
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Appendix A: FTDI Driver Removal and Reinstallation 
The FTDI USB interface IC is often used on evaluation boards. As evaluation software and boards from 
various manufacturers are added to and removed from a PC, occasionally a driver problem will arise.  
 
If the PC running the ZL30250 software is connected to a powered evaluation board but nothing is listed 
in the Device List box in the Device Selection form (or there is a listing of random characters) then the 
first step is to wait 5 seconds then click the Refresh button. Wait and click several times before going on 
to the other steps in this Appendix.  
 
If multiple clicks of the Refresh button don’t cause 0: Dual RS232-HS A to be listed in the Device List 
box then it is likely there is an FTDI driver problem. Follow the steps below to completely remove and 
reinstall the FTDI driver. 
 

1. Disconnect the evaluation board from the PC. 
2. Go to http://www.ftdichip.com/Support/Utilities.htm.  
3. Scroll down to the heading CDM Uninstaller 1.4. 
4. Click the Download CDM Uninstaller link. 
5. Open the downloaded ZIP and the folder inside that. 
6. Double-click CDMuninstallerGUI.exe to run it. 
7. In the pop-up with options “Extract all” and “Run” and “Cancel” click Run. 
8. In the CDM Uninstaller window change Product ID from 6001 to 6010. 
9. Click the Add button. 
10. VID_0403 PID_6010 is displayed. Click on it to highlight it. 
11. Click the Remove Devices button. 
12. After several seconds you should get a pop-up saying “Device removed from system.” 
13. Close the CDM Uninstaller. 
14. You may get a Windows pop-up saying "This program might not have installed correctly." If so, 

click This program installed correctly. 
15. Connect the ZL30250 evaluation board to the PC using a USB cable. 
16. Wait at least 45 seconds for the FTDI part to be recognized by Windows. 
17. Run the ZL30250 executable. 
18. In the Device Selection window you should see 0: Dual RS232-HS A. If not, click the Refresh 

button every 5 seconds until you do. 
19. Click the Connect button. 

 

http://www.ftdichip.com/Support/Utilities.htm�
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Appendix B: Troubleshooting 

Log is Full Error 
If this error occurs follow the steps listed below. So far Microsemi has only seen this with Windows XP. 

• Go to the Windows Control Panel then click Administrative Tools then Event Viewer. 
• In Event Viewer in the left panel, right-click on Application and select Properties.  
• In Application Properties, General tab, under When maximum log size is reached: click the 

Overwrite events as needed radio button and click OK. 
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For more information about all Microsemi products 
visit our website at 

www.microsemi.com 
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